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Trainers use Datafile 2 

 

1 Introduction 
These Training Notes provide a reference during and following RM Asia-Pacific‟s Advanced 
Timetabling training.  They cover all of the main sections of the Timetabling Module.  The 
Timetabling Manual provides a comprehensive guide to the software. 
 
During training we will be working with fictitious data and all the exercises contained within this user 
guide refer to that data.  
 
The training is designed to start with a review of Administration Manager and the Timetabling 
module.  The training will then progress through some of the more advanced functions and features 
of the Timetabling module. 
 

1.1 Timetabling Advanced Training Program 

 

Time Contents 

9.00 am Housekeeping 

Introductions 

9.15 am  Timetabling Parameters 

Timetable Setup 

Timetable Cycles 

Defining Grids 

10.30 am Morning Tea 

10.50 am Individual Grid Parameters 

Student Preferences 

Subject Load Table 

Grid Modelling 

12.30 pm Lunch 

1.10 pm Grid Modelling 

Student Placement 

Resource Allocation 

2.40 pm Afternoon Tea 

3.00 pm Review 
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1.2 Training Outcomes 

 
At the end of the Advanced Timetabling Training program participants should be able to: 
 

 Enter and edit timetabling parameters 

 Create and edit cohorts 

 Enter and edit staff preferred subjects and subject preferred rooms 

 Edit Period Structures 

 Make staff and rooms available to timetabling cycles 

 Define timetabling grids 

 Allocate subjects to grids 

 Allocate grid bands to schedules 

 Enter student preferences 

 Complete subject load tables 

 Copy grid bands 

 Place and remove teaching sets in the grid 

 Complete an inter-grid linkage table according to a plan 

 Complete a time slot map according to a plan 

 Use the auto-scheduler 

 Use the grid modelling tools 

 Allocate teachers and rooms to teaching sets. 
 

1.3 What is the Timetabling Module? 

 
The Timetabling Module assists schools to produce and maintain a comprehensive timetable of 
teaching and learning programs using the information entered in the Administration and 
Timetabling modules.  The system provides a comprehensive set of tools to manage the entry of 
student subject preferences, construction of grids, creation of school timetables and management of 
student courses and resource allocation.  
 
The Timetabling module is one component of a suite of modules that comprise the School 
Information System.  The Timetable module both draws information from and provides information 
to the other Integris modules including Administration Manager, Lesson Attendance and Transitional 
Reporting. 
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1.4 Logging On 

Activity: Logging On 
 

 Double click on the Integris icon on your desktop. 
 

 
 
The Omnis Studio window opens and after a short delay the user login dialog box is displayed: 
 

 Type ADMIN into the User Name field 

 Press <Tab> 

 Type KEYS into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 
 

Note: In schools, each user has their own user name and password, which enables access to 
particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password regularly 
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1.5 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 
Password enables the user to change his or her password.  For security purposes, it is recommended 
that this is done regularly. 
 
Change User should be used to ensure that each person accessing Integris does so under their own 
user name and with their personal levels of access. 
 
Lock Terminal may be used if the user needs to leave his or her computer temporarily, does not 
want to log off and does not want to allow access to anyone else.  Unlocking the terminal requires 
the user to enter his or her password again 
 
Report Destination allows the user to choose where to send any report created in Integris.  The 
options are displayed below. 
 

 
 

Activity: The File Menu 

Top Toolbar > File 

 View each of the following items in the File menu 
o Password 
o Change User 
o Lock Terminal 
o Report Destination 
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1.6 Help Contents and Index 

 

Activity: Accessing Help 

Help > Help Contents and Index 

 
 

 Select Integris Time Help 

 Click Help 
 
The Timetabling Manual will be displayed. 
 

 View the manual 

 Close the Help window 
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2 Constructing the Timetable 
Construction of the timetable may be broken down into the following stages of development.  Please 
note that not all of these steps are required every year.  Those that do need to be completed each 
year are indicated with an asterisk. * 
 

General > School Details 

1. Set up Timetabling Year * 

2. Define Timetable Periods * 

3. Setting Parameters 

 Campuses  

 Physical 

 Logical 

General>Parameters 

 Faculties  

 Departments * 

 Room Types and Rooms * 

 Subject Areas, Classification and Type, and Subjects * 

Timetabling>Set Up 

 Campuses  

 Define Cohorts * 

 Staff Preferred Subjects 

 Subject Preferred Rooms 

 Course Promotion Table 

 Period Types  

4. Define Cycle 

 Add a Cycle * 

 Master Period Structure * 

 Staff Availability * 

 Room Availability * 

5. Define Grids 

 Grid Cohort of Students * 

 Grid Period Structure * 

 Grid Subjects * 

 Grid Subject Groups  

 Grid Rooms  

 Grid Staff  

Timetabling>Preferences 

6. Student Preferences * 

 Individual Entry 

 Bulk Entry 

 Promote Student Courses 

7. Subject Load Table * 

 Edit 

8. Manual Teaching Set Allocation 
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Timetabling>Grid Modelling 

9. Grid Modelling * 

 Manual Set Allocation to Grid 

 Enter constraints 

 Inter-grid Constraints 

 Auto-schedule Process 

10. Refining Student Placement * 

 Fit unplaced students  

 Balance sets  

11.  Map time slots to teaching periods (Functions>Timeslot Mapping) * 

12. Save grid to the timetable (Functions>Save As Timetable) * 

Timetabling>Timetable 

13. Allocate Staff and Rooms * 

 Manual allocation 

 Auto allocation  

14. Lock Timetable 
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3 Review of Administration Manager 
Administration Manager comprising of the Admin and General modules is the basis of the Integris 
software.  Users of the Timetabling module will need to be aware of particular functions within the 
Administration Manager to be able to work effectively in the Timetabling module.  
 
The functions or sections that timetablers should be familiar with are  

 School Details 

 Student Details  

 Staff Details 
 
Other areas that should be investigated are certain parameters that also impact on the timetabling 
process.  These are  

 Departments 

 Room Types 

 Rooms 

 Subjects 
 
 

3.1 Timetable Periods 

General > School Details > Timetabling Periods 

Timetable periods define the start and end dates for the operation of a grid or schedule within the 
timetabling year.  For example a grid or schedule may operate for a term, semester, year or any 
user definable period. 
 
A default timetabling period will be created automatically which spans the whole timetabling year.  If 
the school operates on terms or semesters and these dates have been entered in the school year, 
default timetabling periods based on the entered dates will be created.  The user may accept these 
defaults or create other timetable periods such as learning blocks.  The user must enter the start and 
finish dates of the timetable periods.  Dates must be entered prior to creating a new timetable.  
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ACTIVITY: Defining Timetabling Periods 

General > School Details 

Define Terms 1 to 4  

 Click on Timetabling periods  

 Ensure 2010 is selected 

 Click on  to create term periods 
 

 
 
 

Note: In WA it is not necessary to assign terms to semesters. 
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3.2 Staff Details 

General > Staff Details 

Administration Manager can hold details on both students and staff.  The staffing section of the 
system is accessed via the Staff Details icon on the General side bar.  Functionally it is very similar to 
the student window, using many of the same icons. 
 
 

3.2.1 Entering Staff Details 

General > Staff Details > Add 

To add a new member of staff click on the Add icon.   The following window will appear, 
enabling users to enter the relevant information.   
 

 
 
Mandatory fields are: 

 Surname 

 First Name 

 Date of Birth 

 ID Number 

 Staff Code 
 
It is also good practice to include:  

 Title 

 Gender 

 Staff Type 

 WACOT number 
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To edit a staff member‟s details, display their record by either scrolling through or using the Find 
facility and then click on the Edit icon.  
 

ACTIVITY: Entering a new member of staff  

General > Staff Details 

 Enter yourself as a new member of staff, complete only the mandatory fields, title, gender, staff 
type and WACOT number (on the UDI tab) 

 

 
 

3.3 Parameters 

General > Parameters  

Parameters enable the user to define a list of acceptable options that will be available when data is 
entered.  Appropriate use of parameters will enable the timetabler to search, sort and print data 
relevant to the school‟s structure.  It is recommended that parameters are locked once they are set. 
 
The following parameters will be useful to the Timetabling Module.  Secondary schools may need to 
set up some or all of the parameters below, depending on the structure of each school and other 
factors, for example migrated data. 
 
Faculties provide an organizer for school activity and assists with sorting, searching and grouping of 
data.  Faculties may be physical or logical entities. 
 
Departments provide a secondary organizer for school activity and can be physical or logical 
entities.  Departments can be linked to a faculty but the use of faculties is not mandatory.  For 
example an Arts faculty may contain Art and Drama departments.  This is a mandatory parameter 
for timetabling purposes. 
 
Room Types define the different categories of rooms available in the school, for example Science 
Labs, Art rooms, Classrooms etc.  These rooms can be linked to specific subjects.  While the Room 
Types parameter is not mandatory for timetabling, it is very useful and users are recommended to 
take advantage of it. 
 
Rooms define the actual individual rooms available within the school.  The user must enter in all 
rooms of the school if rooms are to be listed on the timetable.  This is a mandatory parameter for 
timetabling purposes. 
 
Subject Areas provide an additional means of grouping subjects. For example by defining a “food” 
subject area the timetabler can identify all subjects relating to food.   While this parameter is not 
mandatory for timetabling, it is essential for Formal Reporting as it enables the linking of contexts to 
learning areas. 
 
Subject Classifications are ways of classifying subjects for monitoring purposes, for example. TER List 
1.  While this parameter is not mandatory for timetabling, it is very useful and users are 
recommended to take advantage of it. 
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Subject Types are ways of identifying subjects for Curriculum Council purposes, for example TEE, 
WSA.  While this parameter is not mandatory for timetabling, it is essential for reporting to the 
Curriculum Council. 
 
Subjects may define an individual subject for example, English or the components of courses offered 
by the school.  They will contain the default values such as class size, frequency etc.  This is a 
mandatory parameter for timetabling purposes.  
 
All Parameters may be added or edited, printed, locked, made active or inactive and/or made the 
default parameter. 
 
The parameters to be created need to be set up in the preceding sequence.  
 

3.3.1 Departments 

General > Parameters > Departments  

Use the Add  function or Edit  as required. 
 

 
 

 
 

Use Copy Selected Parameter  to quickly create similar departments.  Highlight the Department 
to be copied. 
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Note: Faculties and Departments may be set up when the school‟s data is migrated from their 
current school administration system. 

 

3.3.2 Room Type 

General > Parameters > Room Type   

It is not mandatory to set up room types but it is useful to be able to organise rooms by type. 
 

Use Modify and Add Parameters to add and edit room types. 
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3.3.3 Rooms 

General > Parameters > Rooms  

Use Add  to add rooms.   
 
Once a room has been set up, details of similar rooms can be quickly set up.   

Highlight the Room to be copied and use Copy Selected Parameter    
 

 

           
 

Note: Rooms will be set up when the school‟s data is migrated from their current school 
administration system. 

 

3.3.4 Subject Area 

General > Parameters > Subject Area  

Use the Add  and Edit  to add or edit subject areas. 
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Note: While Subject Area is an optional parameter for Timetabling, it is crucial for Reporting to 
Parents that each Subject is linked to a Subject Area and each Subject Area is linked to a Learning 
Area.  

 

3.3.5 Subject Type 

General > Parameters > Subject Type  

Use the Modify/Add Parameters button  to add subject types. 
 

 
 

Note: Only subjects with the type TEE, WSA, COS, VETCOS or CEP will be included when reporting 
to the Curriculum Council.   

Only Year 12 subjects which include the Tertiary Entrance Examination may be given the type TEE. 

 

3.3.6 Subject Classification 

General > Parameters > Subject Classification  

Use the Modify/Add Parameters button  to add subject classifications.   
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3.3.7 Subjects 

General > Parameters > Subjects  

Use the Add  and Edit  buttons to add and edit subjects. 
 

 
 
It may not be necessary to use all of the fields for all subjects.  Fields which should be entered are: 

 Subject Name 

 Subject Code 

 Short Name 

Note: For WACE Courses the Short Name should be the three digit Course code. 

 Subject Area, which will also load Learning Area provided that has been entered in Subject Area 

 Department, which will also load Faculty and Department Head if these have been entered in 
Department 

 Frequency 

 Maximum Class Size 
 
For Curriculum Council accredited subjects, other necessary fields are: 

 Subject Type 

 Subject Classification 

 Moderating Teacher (Contact Teacher in the Subject Register) 
 
Timetabling defaults should be entered here.  They can be edited in the Timetabling module but 
global parameters are entered here. 
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ACTIVITY Setting Parameters 

General > Parameters > Departments 

Make Paul Gabelich the Head of Administration 

 

 Click Department Name to sort departments alphabetically 

 Highlight Administration and unlock  

 Click Edit  

 Click Find  

 Enter the GAB in the Name/Number field 
 

 
 

 Click Find 

 Check Locked and click OK 

 Close the Departments window 
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General > Parameters > Room Types 

Enter a new room type: Duty Area. 

 Right click on the yellow screen 

 Select Add/Edit Parameters 
 

 
 

 Enter a code and description 
 

 
 

 Click OK 

 Lock the new parameter  
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General > Parameters > Rooms  

 Add  Duty Area 1 
 

 
 

 Copy  to Duty Areas 2 to 6 
 

 
 

 Close the Rooms window 
 

General > Parameters > Subject Type 

 Click Modify Parameters  

 Enter V, VETCOS and VET Course of Study 
 

 
 

 Click OK 
 
 

Note: Only subjects with the type TEE, WSA, COS, VETCOS or CEP will be included when reporting 
to the Curriculum Council.   

Only Year 12 subjects which include the Tertiary Entrance Examination may be given the type TEE. 
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General > Parameters > Subject Classification  

 View the parameters 
 

 
 
 

General > Parameters > Subjects 

 Add  Yard Duty as a subject 
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4 Timetabling 
The Timetabling Module must perform two important functions.  It must facilitate the creation of a 
timetable, which satisfies the educational requirements of the school, and also provide an 
environment for the efficient day-to-day maintenance of the timetable. 
 

4.1 Using the Timetabling Sidebar 

 

 

 
The Timetabling sidebar allows users to set up, create and maintain the 
school‟s timetable for current and future years.  
 
Student Course displays for each student a list of preferences, the student‟s 
timetable and the relevant grid for the student with his or her teaching sets 
highlighted. 
 
Timetable displays the current whole school timetable that may be filtered by 
year, cycle, schedule, grid or department. 
 
Grid Modelling allows the user to either manually manipulate the grid or define 
constraints and use the auto-scheduler to model the grid or a combination of 
both. 
 
Preferences refers to the entry of student‟s subject preferences which may be 
entered either on an individual or group basis. 
 
Reports allows the user to access a list of timetable reports divided into three 
main areas: Data Validation Reports, Planning and Preparation Reports and 
Operational and Maintenance Reports. 
 
Timetable Set-up allows the user to define all aspects of the timetable prior to 
creation of a new timetable. Timetable set up can be completed at any time for 
future timetables. 
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4.2 Timetabling Terminology and Concepts 

The TIMETABLE is a tool that enables the resource needs of the school to be managed. A school‟s 
timetable is a plan of the student‟s time, which indicates the subject being studied, its location, the 
teacher taking the class and the frequency of the subject. The subject choices of students need to be 
satisfied within the constraints imposed by the limited resources of teachers and rooms. 
 
The TIMETABLING YEAR holds all of the school‟s timetabling activity within the school year.  Integris 
will store past, present and future timetables enabling users to move between timetables. Within a 
timetable year, a CYCLE contains information regarding Cycle dates and period structures drawn 
from the school calendar and connects with the Lesson Attendance module.  Cycles can be defined 
for each logical or physical CAMPUS. Students grouped together for timetabling reasons are 
identified as a COHORT and students may belong to multiple cohorts. 
 
GRIDS are the focus of timetabling activity and can be created or cloned from previous years. All 
Staff, rooms and subjects can be made available or unavailable, where required, to a grid.  The 
grid provides the framework within which the teaching sets required to satisfy the selections of 
students within the grid will be placed. 
 
Grids are made up of BANDS, which are similar to gridlines, but are divided up into BAND 
RECORDS.  Band records can be individually manipulated and ultimately represent a single 
occurrence of that combination of teaching sets on the timetable. 
 
Student PREFERENCES (subject selections), as well as reserve preferences, may be allocated, 
individually or in bulk, selected from groups or promoted from the previous year. 
 
Grids may be created manually or by using the AUTO-SCHEDULER or using a combination of the 
two to add some fixed elements.  The auto-scheduler can take into account a wide range of 
constraints when determining the optimal solution. 
 
Grid manipulation is referred to as MODELLING, and a comprehensive set of tools is available to 
assist with the modelling process from horizontal and vertical representations of the grid.  Modelling 
can be used to construct a grid manually, as in Fixed Grid schools or to manipulate the output from 
the auto-scheduler. 
 
Grids are assigned to one or more SCHEDULES.  Schedules have a defined period of activity and a 
TIMETABLE will be a combination of all events active at a particular time.  
 
Each period of time for which the timetable remains unchanged is known as a TIMESLICE.  The 
timeslices required by the timetable are calculated automatically by the system by examining each of 
the schedules linked to grids. 
 
The timetable applicable to any date during the year can be selected by choosing the appropriate 
timeslice from a list of date ranges provided. 
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4.3 Timetable Set Up 

Parameters created in Timetable Set Up may apply to more than one timetabling year.  These 
parameters need to be entered once and are then modified as required prior to creating a new 
timetable.  These functions may be modified during the year if necessary. 
 
The following screen shows the Timetable Set-up menu: 
 

 
 

4.3.1 Cohorts 

A cohort is a group of students who will be timetabled within a grid.  Usually a cohort will consist of 
a year level or class, for example all year eight students may be included in a cohort.  However the 
students who may be included in a cohort is only limited by the constraints of the school.  Cohorts 
may be associated with more than one timetabling period e.g. the same Year 9 cohort may be 
associated with Semester 1 and Semester 2. 
 
Students will be selected for a cohort using the student FIND tool or by cloning a cohort from a 
previous timetabling period and renaming it.  It is also possible to define cohorts within Groups if 
the user wishes. 
 
Students may be added to the cohort as required.  They may also be removed from the cohort if 
necessary.  However if the student has subject preferences or teaching sets attached the user will be 
warned of this when removing the student.  If a student is removed from a cohort the class totals will 
reflect this change and the student will be removed from any associated teaching sets. 
 
Students listed on the admissions roll may be added to cohorts at any time.  However as a student is 
moved from admissions to the current roll, the user will not be prompted to add the student to a 
cohort even if he or she is not already in a cohort.  
 

Note: Users entering students after the timetable has been created will be prompted to select a 
cohort at time of enrolment.  Users moving students to the former roll will be prompted to remove 
the student from the cohort.  However the user will also have the option to have the leaving student 
remain in a current cohort.  These students will be highlighted in red on class rolls to distinguish 
them from current students. 
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ACTIVITY: Cohorts 
 
Note: Before creating cohorts, consider the grids that you will be using.  For example, many schools 
have an Upper or Senior School grid that includes both Years 11 and 12. 

Timetabling > Timetable Set-up > Cohorts 

Add a Duty cohort 

 Ensure 2010 school year is selected 

 Add  a Yard Duty cohort, do not add any students 
 

 
 

Add the Year 11 student on the Admissions roll to the Upper School cohort. 

 Highlight US 

 Click Find Students  on the right 

 Find the Year 11 student on the Admissions roll 
 

 
 

 Scroll down to check that George Pyatt has been added 
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4.3.2 Staff Preferred Subjects 

The Timetabling module is able to manage and monitor the allocation of staff to the timetable.  This 
will only be possible if the subjects that a staff member is able to or designated to teach are 
recorded.  This is an optional process and if no preferred subject information is recorded for staff 
then the timetabler must manage staff allocation manually. 
 

 
 
Staff preferred subjects might be based on qualifications, experience and/or preference.  This 
information may vary from year to year but can be cloned from a previous year and then modified.  
The preferred subject(s) may be prioritised using a ranking system between 1 and 10.  A staff 
member may also nominate a room as the preferred room.  If resource monitoring is enabled, the 
auto-scheduling process will take into account the preferred subject(s) for staff as an additional 
factor when determining the placement of subjects on the grid.  
 
 

Activity: Staff Preferred Subjects and Rooms 

Timetabling > Timetabling Set-up > Staff Preferred Subjects  

Allocate your preferred subjects and room 

 Find  your records 

 Click Edit  

 Click Subject Name to sort subjects alphabetically 

 Holding down <Ctrl>, highlight your preferred subjects 

 Click Add Selected Subjects  

 Highlight one of the subjects in your list and in the bottom right hand corner type 2  

 Press <Enter> 

 Give another subject a ranking of 3 
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Add your preferred room  

 Click Edit Preferred Room   

 Click Find 
 

 
 

 Highlight a room in the list 

 Click Select and OK 
 
 
 

4.3.3 Subject Preferred Rooms 

The user may wish to define one or more preferred rooms for a subject. If preferred rooms are 
assigned to a subject, the room allocation process will offer these rooms for manual allocation, 
automatically assigning those flagged as „must have‟ first. Only one room for each subject may be 
flagged as „must have‟. Rooms that are allocated „Must not have‟ will not be allocated to the linked 
subject. Preferred rooms may be cloned and/or edited for use in future timetables. 
 
Preferred rooms may be ranked as  
1. Must Have 
2. Highly Desirable 
3. Desirable 
4. Take if Necessary 
5. Must Not Have 
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Activity: Subject Preferred Rooms 

Timetabling > Timetable Set-up > Subject Preferred Rooms 

Make the Duty areas Desirable for Yard Duty 

 Click Bulk Allocation  

 Use Subject Find to find Yard Duty by its code YD 

 Use Room Find to find the Duty Areas by their Room Type -  Duty Area 
 

 
 

 Change the Room Rank to Highly Desirable and click Update Selected Rooms  

 Click Add Rooms and Yes 

 Close the Bulk Allocation window 
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4.3.4 Promoting Student Courses 

Timetabling > Timetable Set-up > Maintain Course Promotion Table 

Promotion of a student‟s course is a tool designed to make entry of subject preferences easier.  
Students who studied a pre-requisite subject in one timetabling period may want to list the 
subsequent subject as a preference for the next timetabling period.  By using the promote student 
course function entry of the preference is automatically updated for selected students. 
 
If the user wishes to promote a student‟s courses from one timetabling period to another, the 
promotion path for the subject must be defined showing how students will be moved from a subject 
in one timetabling period to a subject in a subsequent period.  The Course Promotion Table 
performs this function and will need to be set up prior to the course promotion function being 
invoked.  The Course Promotion Table will apply to all timetabling years and grids so need only be 
set up once and then edited as required.  
 
The table will be used to take all students studying a subject in one timetabling period to be 
promoted to a different subject in a subsequent timetabling period. For example, students studying 
Year 8 English could be promoted to Year 9 English in the following year.  Not all subjects within a 
student‟s course need be promoted.  When applying the course promotion table, the timetabler is 
able to selectively enable or disable the promotion of each subject or, if appropriate, individual 
students within each subject. 
 

Editing the Course Promotion Table 

The Course Promotion Table is accessed from the Timetabling > Timetable Set-up > Course 
Promotion Table. 
 

Note: Only those subjects used for promotion need be defined.  The Promote Student Course 
function is only available and initiated from the Bulk Student Preference window. 
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ACTIVITY: Promoting Courses 

Timetabling > Timetable Set-up > Maintain Course Promotion Table 

Enable the promotion of students of Year 11 English subjects to the same subjects in 
Year 12  

 Click Edit  

 Click Show available subjects    

 Drag the Available Subjects window to the right of the Course Promotion Table 

 Drag and drop Home Room 11 into the From column  

 Drag and drop  Home Room 12 into the To column 

 Repeat for all the English courses, as shown below 
 

 
 

 Click OK and Yes 

 Close 
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4.3.5 Department Colours 

Users have the ability to identify Departments with colour to simplify the identification of the location 
of Teaching Sets on the grid.  Once assigned, these colours will appear wherever a grid view is 
available, that is in Student Course, Grid Modelling and in reports showing the grid.  

 

Activity: Assigning Department Colours 

Timetabling > Timetable Set-up > Department Colours 

 
 

 Highlight Computing  and click Edit Details 
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 Select a colour and click OK 

 Repeat for the other departments, if you wish 

 Click OK to close 
 
 

Note: The colours may be turned off by clicking Clear Colour Scheme.  
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4.3.6 Timetable Cycles 

At least one timetable cycle must be defined for each timetabling year and contains the details of the 
cycle dates and period structures the school will use.  The timetable cycle draws details from the 
school calendar and forms the connection to the Lesson Attendance Year.  
 

 Cycles may remain in use for a number of years or may change from year to year.  

 A cycle will be linked to the timetabling year via the grids that use it and may be cloned and/or 
edited for use in future years.  

 The number of days within a cycle is unlimited. If a 5-day cycle is chosen the day names will 
default to Monday, Tuesday etc.  If any other cycle is chosen the day names will default to Day 1, 
Day 2 etc.  The day names are editable if required. 

 Cycle details may be added progressively over time.  

 A row refers to a line on the timetable and this may be a teaching period or a break, for 
example lunch.  Therefore 5 rows per day may indicate 5 teaching periods or any combination 
of teaching periods and breaks, for example. 3 teaching periods and lunch and recess. 
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Activity: View the Cycle for 2010 

Timetabling > Timetable Set-up > Timetable Cycles 

 Click Edit Cycle  

 View the cycle for 2010 
 

 
 

 Click Cancel 
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Master Period Structure 

The maximum number of periods and the timing of the periods required by any cohort using the 
cycle must be defined.  Where cohorts use variations on the default structure, grid definition will 
allow masking of unused periods for a particular cohort. 

Note: The master period structure can be edited at the time of cycle creation or at a later point if 
required. 

If the user would like to show breaks, e.g. lunch, recess and/or sporting activities these must be 
included when calculating the number of rows per day and then include these breaks and/or 
activities when inserting the timing of periods.  Rows may be added to the Master Period Structure 
following the creation of the timetable to accommodate breaks, form or other changes using the 
Add Above or Add Below buttons. 
 
Variations to the day structure across grids, such as early starts, late closing or staggered lunch 
breaks, can be accommodated by marking those periods as unavailable (masked) within Individual 
Grid Parameters.  For example, if the Year 8 students have lunch from 12 noon to 1pm, and all 
other Years have lessons at that time, this period can made unavailable (masked) for the Year 8 grid 
only. 
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ACTIVITY: Editing the Master Period Structure 

Timetabling > Timetable Set-up > Timetable Cycles > Master Period Structure 

 Click Edit  near the centre of the window 

 Change the Period Types for rows 4 and 7 to T for Monday 
 

 
 

Note: This will allow us to timetable yard duty. 

 
 

 Click Copy  

 Copy Day 1‟s period times to Days 2 to 5 
 

 
 

 Click OK twice 
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Staff Availability 

Staff must be made available to the cycle to be allocated classes within the grids.  The Full Time 
Equivalency (FTE) of the staff must be added, edited or cloned in this window.  The FTE is drawn 
from the Default FTE in School Details that should be marked as 1.00.  Non-teaching activities e.g. 
DOTT may be defined for staff and are used to calculate Net FTE which is used by the auto-
scheduling process.  The Net FTE is important as the auto-scheduling process takes this into account 
when allocating classes to staff.  Net FTE for timetabling purposes is defined as the contact time for 
each teacher, that is a Net FTE of 1.00 means that the teacher is available to teach all teaching 
periods.  
 

Note: If any staff member has an FTE of 0.00 the auto-schedule process will not be able to allocate 
that staff member to any class. 
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ACTIVITY: Adding Staff to a Cycle 

Timetabling > Timetable Setup > Timetable Cycles > Staff Availability 

Allocate yourself to the 2010 cycle 

 Click Add  

 Enter the first three letters of your surname into the Name/Number field and click Find  
 

 
 

Edit your Net FTE 

 Highlight your name in the list and click Non-teaching Activities  

 Click Edit  

 Enter a Code, Description and FTE 
 

  
 

 Click OK, Yes and Close 
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Room Availability 

A set of rooms must be made available to the cycle.  They may be shared between campuses using 
the same cycle.  Rooms must first be entered within the Administration Manager to be able to be 
allocated to a cycle.  Rooms may be cloned from one cycle to another.  Rooms cannot be shared 
between cycles in the same timetabling year. 
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ACTIVITY: Allocating Rooms to a Cycle 

Timetabling > Timetable Set-up > Timetable Cycles > Room Availability 

Allocate Duty Areas to the 2010 5 Day Cycle 

 Click Add  

 Find by Room Type: Duty Area 
 

 
 

 Click Select and Yes   
 

 Close Timetable Cycles 
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4.3.7 Defining the Grid 

Timetabling > Timetable Set-up > Timetable Grids 

Grids are the frameworks for development of the whole-school timetable for a timetabling year, 
ensuring the best use of available resources.  Grids may be created or cloned from a previous year 
and renamed and linked to a campus, a cycle, staff, rooms and subjects.  The grid is linked to a 
timetable period that identifies the length of time the grid remains active.  Grids may be linked to 
one or more schedules, for example the Year 12 grid may be linked to the Semester 1 and 2 
schedules. 
 

 
 

Note the option to Show Teachers and Rooms on Grids. 

Adding or Cloning a Grid 

Timetabling > Timetable Set-up > Timetable Grids 

Grids may be created or cloned from previously defined grids. 

Adding a Grid 

 Click Add  
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 Enter Name of Grid, Grid Code and Number of Bands 
 
The number of bands will usually reflect the number of subjects students study during the timetabling 
period linked to the grid.  This is a starting value only and may be changed later, provided teaching 
sets have not yet been placed on the grid concerned.  The frequency for the bands should relate to 
the number of times students will attend the classes placed on that band during a cycle, for example, 
four times per week   

Note: These values may also be edited at a later date, provided teaching sets have not yet been 
placed on the grid concerned. 

 Select the appropriate Cycle, Campus, Cohort and Timetabling Period using the drop down 
boxes 

It is strongly recommended that a timetable period of the school 
year is always selected, at least initially, to allow for maximum 

flexibility 

 Indicate whether this grid is linked to Upper school by checking the Upper School tick box 
 

 
 

 To have the ability to leave Teaching Sets on the Grid in the positions in which they are placed in 
Grid Modelling tick the box next to the field Editable Grid Display 

 

 
 

 Click OK and then click Yes 
 

Cloning a Grid 

 Click Add  

 Click Clone Grid and select an appropriate grid 
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 Change the name, cycle etc. for the new grid 

 Click OK 

 Click Yes 
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Editing a Grid 

Timetabling > Timetable Set-up > Timetable Grids 

Note: Grids may be edited in this view only before teaching sets have been placed on the grid 
concerned.  After this, grids may still be edited in Grid Modelling. 

 

 Highlight the appropriate grid 

 Click Edit  
 

 
 

 Amend fields as required 

 Click Close 

Adding a Band 

 Click Edit  
 

 
 

 Change the number of bands to the new value 

 Highlight the new band in the pane on the right 

 Enter the appropriate frequency by clicking on the grey arrows to the right  
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 Click Close. 
 

Deleting a Band 

 Highlight a band  

 Click on Delete   

 Confirm your selection 

Increasing/Decreasing a Frequency of a Band 

 Highlight a band. 

 Click on  to increase the frequency 

 Click on  to decrease the frequency 

Note: Band frequencies can only be edited within this screen prior to the placement of teaching sets 
on the grid.  Following this, changes can only be made within the Grid Modelling screen.  It is 
suggested that where possible, the band frequencies be defined at this point. 

 

Deleting a Grid 

Timetabling > Timetable Set-up > Timetable Grids 

 Highlight the appropriate grid 

 Click Delete   

 If the highlighted grid has been saved to the timetable you will be required to enter a password 
 

 
 

 Enter the password and click OK 
 

 
 

 If you click Yes another warning message will appear: 
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 Click Yes to delete the grid 

 Click No to cancel the selection 

Note: If the Grid has been saved to the timetable only those users with an administrator status may 
delete the grid.  The user will be asked to confirm their password before continuing with the above 
process. 

 

Important:  

Deleting a grid will remove all grid elements including subjects 
allocated to the grid and student preferences, as well as the 

placement of these in grid modelling. 

 

Remove Non-fixed Teaching sets 

This feature allows for any non-fixed teaching sets to be removed from a grid. They will not be 
deleted and will retain their students. 
 

 Highlight the appropriate grid 

 Click Remove Non-fixed Teaching Sets  

 If the highlighted grid has been saved to the timetable you will be required to enter a password 
 

 
 

 Enter the password and click OK 

 The following message will display 
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 Click Yes to remove Non-fixed Teaching Sets from the Grid 

 Click No to cancel the selection 

Note: If the grid selected had been saved to a timetable only those teaching sets that were fixed on 
the grid would still maintain staffing and room allocations on the timetable. 
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ACTIVITY: Creating/Editing Grids 

Timetabling > Timetable Set-up > Timetable Grids 

 

 

Note the option to Show Teachers and Rooms on Grids. 

Complete the Upper School grid 

 Highlight the Upper School grid and click Edit  
 

 Check Upper School  
 

 
 

 Close 
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Define the Yard Duty grid 

 Click Add  

 Enter the following information: 
 

 
 

 Click OK and Yes 
 
 

4.4 Individual Grid Parameters 

Once the user has created or cloned a grid, parameters for each individual grid can be viewed and 
refined further.  If the parameters have not been previously selected in the grid definition screen the 
panes will appear blank. 
 

Grid Cohort of Students 

A list of member students in the cohort will be displayed.  A cohort may be linked to several grids in 
one year.  However, only one grid may be attached to one cohort. 
 

 

Note: If a cohort has not been selected for the grid this pane will be blank. 

Students cannot be added or removed from the cohort within this screen.  This function is performed 
within the Cohort parameter.  
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Grid Subjects 

A list of subjects should be made available to the grid so that student subject preferences are 
validated upon data entry. 
 
The subject tab will allow a list of subjects to be selected using a subject FIND tool and linked to the 
grid.  For subjects to be available they must have been previously defined in the Administration 
module (General>Parameters>Subjects).  The subjects may be selected for the grid at any time 
prior to the entry of subject preferences.  Subjects may be cloned or edited for use with future grids.  
Subjects may be deleted from the grid subject list if no preferences have been recorded for that 
particular subject. 
 
Subjects made available to the grid will inherit default information from the subject parameter table 
or grid from which they are cloned.  This information will need to be verified and modified where 
there are differences applicable to an individual grid,  
 
Aspects of subject information that should be checked are: 
 

 Subject Frequency - the subject frequency will usually indicate the number of times a teaching set 
will meet during a cycle – for example, four times per week (in a five day cycle). 

 Minimum and maximum class sizes 

 Gender mix 

 Required Subject - ensure that the required box is checked.  A required subject means any 
student with this subject listed as a preference must be allocated the subject, examples of 
required subjects could be English, Maths etc.  

 
If any of the above defaults are edited they will only affect the selected grid.  If the changes are to be 
global the information should be edited in General>Parameters>Subjects. 
 

 
 
Grid subjects will be made available to bands that have a frequency that matches the subject 
frequency.  The available bands for the subject can then be individually edited. Planning of band 
and subject frequencies prior to selecting subjects for a grid will simplify this process. 
 

Note: Subjects cannot be deleted from this list if preferences have been recorded for the subject. 
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ACTIVITY: Allocating subjects to a grid 

Timetabling > Timetable Setup > Individual Grid Parameters > Subjects 

 Select the Upper School grid 

 Click Set grid as default  

 View the subjects added to the Upper School Grid 

 Click Add Subjects  

 Enter the following and click Find 
 

 
 

 Click Select and Yes 
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Add Yard Duty as a subject to the Yard Duty grid 

 Select the Yard Duty grid 

 Click Add Subjects  

 Enter the Subject Code YD and click Find 
 

 
 

 Click Select and Yes 
 
 
 

Grid Band Allocation 

Band Allocation allows the user to change or add schedules to the grid. Once the grid has been 
saved to the timetable, band allocation may not be changed. Common band allocation may show 
two semesters within the same grid. 
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Changing Schedules 

 Select the appropriate school year and grid. 

 Click on the Band Allocation tab. 

 Click on  

 Confirm your intention. 
 

 
 

 Highlight an appropriate schedule. 
 

  
 

 Click OK. 
 

Adding Schedules 

 Select the appropriate school year and grid. 

 Click on the Band Allocation tab. 

 Click on  

 Highlight an appropriate schedule. 
 

  
 

 Click OK 
 

 Click in the appropriate bands to indicate which bands are allocated to which schedules. 
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Note: You may only add future schedules to Band Allocation.  Bands may be allocated to all 
schedules or to one only. 

 
 

ACTIVITY: Allocating Grid Bands to Schedules 

Timetabling > Timetable Setup > Individual Grid Parameters > Band allocation 

 Select the Yard Duty grid 

 Click Change Schedules and Yes 

 Highlight Terms 1 to 4 and click OK 
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 Select the Upper School grid 

 Click Change Schedules and Yes 

 Highlight Semesters 1 and 2  and click OK 

 Click in Band 2 for Semester 2 to make it unavailable to that semester 

 Repeat for Bands 3 to 7 
 

 
 

Note: Later we will copy Bands 2 to 7 into Semester 2 
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4.5 Student Preferences 

Student Preferences are a list of subjects in a ranked order that a student has selected to study.  
 
Preferences may be entered and maintained either for individual students or groups of students.  
Once the timetable has been created student courses may be altered individually if required.  
Preferences will be ranked by the following classifications: 
 

 Required – all ranked as 1.  Required subjects must be allocated to a student e.g. English 

 Primary Electives – ranked in ascending order.  Primary Electives are those the student considers 
most important.  

 Reserve Electives – ranked in ascending order.  Reserve Electives are those subjects nominated by 
the student in case any of his or her primary electives are disallowed. 

 
Preferences for a student will apply to a grid.  If a student is a member of more than one cohort, 
preferences will have to be entered for each grid.  Student preferences may be allocated via a 
combination of both bulk and individual entry.  For example all required subjects may be entered 
via the bulk entry screen and electives may be entered individually. 
 

  
 

Note: Prior to entry of student preferences, subjects and/or subject groups must be defined for the 
associated grid.  If no subjects have been defined for the grid the user will be unable to enter 
student preferences. 

 
Student Preferences may be entered by 

 Individual entry; 

 Bulk entry of preferences or 

 Promotion of some or all of a student course from any earlier grid 
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4.5.1 Individual Entry of Student Preferences 

Timetabling > Preferences > Preferences by Student 

To select one or more students for individual entry of preferences, highlight the students within the 
Preferences by Student window and click on the View Details icon. 
 
For each student individual preferences are entered by dragging subjects from the subject list or 
typing the subject code and ticking the required box as necessary. Preference order may be changed 
up or down as required.  If a browse set has been chosen i.e. a group of students highlighted from 
the cohort list, use the blue arrows to move between the selected students. 
 

 
 

 

Add preference 
 

Edit Preference 
 

Add subject group 
 

Delete preference 
 

Toggle Reserve/Primary 
 

Place in T-set  
 

Remove from T-set 

 

Note: Students must be included in a cohort and subjects allocated to the grid prior to entry of 
preferences. 
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4.5.2 Bulk Entry of Student Preferences 

Preferences may be entered in bulk by defining a list of subjects or subject group and groups of 
students to which they may be allocated.  
 
Courses may be promoted from last year via the course promotion screen.  To be promoted these 
courses must have been previously defined in Timetabling>Timetable Set-up>Maintain Course 
Promotion Table.  Courses may be promoted from a previous year or semester grid.  
 

 
 

Adding preferences in bulk to a group of students 

 Highlight students in the cohort and click on the arrows  

 Highlight the required subjects and click on the arrows 

 Click Add 
 

Removing preferences in bulk from a group of students 

 Highlight students in the cohort and click on the arrows  

 Highlight the required subjects to be removed and click on the arrows  

 Click Remove 
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Activity: Adding Preferences in Bulk 

Timetabling > Preferences > Bulk Student Preferences  

Add Home Room 11 as a subject for all current Year 10s 

 Click Select students  

 Find the current Year 10 students  
 

 
 

 Move the selected students to the right  

 Move Home Room 11 to the right 
 

 
 

 Click Add 
 
 
  



 

Time Advanced.docx 16-Sep-09 

Page 65 of 123 

   © 2009 RM Asia-Pacific Pty Ltd 

 

 

4.5.3 Promoting Student Courses 

The promotion of student courses from a previous grid is initiated from within the Student Preference 
> Bulk Entry Window 
 

 Click Promote Courses from a Previous Grid 
 

 
 

 Highlight the appropriate grid and click OK  
 

 
 

Note:  There is an option to retain all teaching sets.  

  



 

Time Advanced.docx 16-Sep-09 

Page 66 of 123 

   © 2009 RM Asia-Pacific Pty Ltd 

 

 

 
 

 Edit as required 

 Click OK   
 

 

Allows the user to deselect students from course promotion 
 
Allows the user to deselect subject from course promotion 
 
Allows the user to select which teaching sets are to be retained 

 

ACTIVITY: Student Course Promotion 

Timetabling > Preferences > Bulk Student Preferences  

Promote all Year 11 students to selected Year 12 courses 

 Click on Promote Courses from a Previous Grid  

 Highlight 2009 US  
 

 
 

 Click OK 
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 Highlight the first line in the table 
 

 
 

 Click Retain Teaching Sets  

 Check Retain Group for each Home Room 
 

 
 

 Click OK twice 
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ACTIVITY: Individual Course Entry 

Timetabling > Preferences > Preferences by Student 

 Click on to column heading No.Prefs  
 

 
 
George Pyatt has no preferences 
 

 Highlight his name and click View Details  

 Click Show/Hide Subject List 

 Drag and drop the equivalent of eight year-long subjects into his preference list 

 Toggle two of these subjects to Reserves  
 

 
 

 Close Individual Student Preferences 
 
 
  



 

Time Advanced.docx 16-Sep-09 

Page 69 of 123 

   © 2009 RM Asia-Pacific Pty Ltd 

 

 

4.5.4 Subject Load Table 

A subject load table will be maintained for each grid and contains a summary of the information 
relating to each subject made available to the grid.   
 
The major function of the Subject Load Table is to present information that will allow the number of 
sets for each subject to be appropriately set.  This decision will be based upon the number of 
primary and reserve preferences selected by students and the availability of staff and room 
resources.  Non-viable subjects may also be identified in this process with the resultant need to refit 
affected students. 

Note: Grid modelling of teaching sets is not possible until the number of teaching sets to be made 
available has been defined  

By default the table will display subjects made available to the grid that have student preferences 
recorded.  By clicking on the Show/Hide No Preferences button all subjects made available to the 
grid will be displayed. 
 

 
 
The table will display all defined subjects for the grid including such information as how many 
students have elected the subject as a primary or reserve preference, the default minimum and 
maximum class size, the default frequency, whether it is a required subject and an amount of 
unallocated places left in the class.  Using this information, the number of teaching sets for each 
subject may be planned and edited.  From this screen, the number of teaching sets required, default 
class sizes, frequency of the class and whether the subject is a required subject, may also be edited.  
The other fields are populated based on information from this screen and the student preferences 
screens. 
 
Next to the number of teaching sets for a subject is a button which if clicked will display a list of 
teaching sets for that subject.  The maximum and minimum class size for each set can be 
individually edited.  To edit the subject details click on the Edit button and type information into a 
selected cell. 
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At the bottom of the screen a series of totals are displayed.  The Number of Students is the total of 
students defined in the cohort.  Students with no Preferences shows the number of students in the 
cohort but with no preferences listed.  Underloaded Students lists the number of students who do not 
have a full study load.  Number of Subjects lists the total number of subjects defined for the grid.  
Singletons lists the number of subjects with only one teaching set.  Multi-Set shows the number of 
subjects with more than one teaching set.  Number of Proposed Sets lists the number of all teaching 
sets defined for this grid.  Number of Proposed Periods shows the number of all teaching periods 
defined for this grid. 
 
The confirmation or editing of subject frequencies may be defined in one of three places.  The 
frequency may be entered when defining the subjects for a particular grid (Timetabling>Timetable 
Set-up>Individual Grid Parameters>Subjects) or it may be edited in the subject load table 
(Timetabling>Preferences>Subject Load Table) or within the vertical grid view of grid modelling 
(Timetabling>Grid Modelling>Vertical View). 
 

Note: The Auto scheduler makes use of maximum and minimum teaching set sizes to determine the 
placement of teaching sets on the grid.  Always check that entered values are correct.  Once the grid 
has been modelled and saved as a timetable, changes made to the minimum and maximum class 
sizes will not affect the number of teaching sets.  Any changes to class sizes must be completed prior 
to grid modelling either manually or using the auto-schedule process. 

 

Collapsing Non-Viable Subjects 

The timetabler may identify subjects that have been made available to the grid but are considered 
not viable to operate within the timetable being constructed.  A number of factors will be considered, 
one of which is the number of students selecting the subject as a primary or reserve preference. 
 

 
 
If the number of sets for these subjects is set to zero within the load table, then teaching sets of these 
subjects will not be available to the grid modelling process for manual or auto scheduler placement.  
However if student preferences are not adjusted then the student will ultimately remain unplaced.  To 
identify the students involved, print the report „Students Choosing a Subject‟ from the reports menu 
within the timetabling sidebar.  These students can then be individually selected and edited within 
the Preference function or the subject can be removed from all students using the Bulk Allocation 
window, Remove function. 
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ACTIVITY: Editing Subject Load Tables 

Timetabling > Preferences > Subject Load Table 

 Click Edit 
 

 
 

 Enter the number of teaching sets for each subject 

Note: Leave the number of teaching sets for all 1B, 1D, 2B and 3B subjects at zero.   

 Click OK to save 
 
 

 Select the Yard Duty grid 
 

 Click  

 Click Edit 

 Enter the number of teaching sets as six (one for each duty area) 
 

 
 

 Click OK   
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4.6 Grid Modelling 

Construction and manipulation of the grid is referred to as grid modelling.  
 
A comprehensive set of tools is available to the user to assist with the modelling process.   
The Grid Modelling screen will allow definition of constraints to be applied to a particular grid and 
the construction of the grid allowing for defined constraints.  
 
The grid may be developed in one of three ways: 

 Manually placing all elements on the grid and generating nothing (that is creating a fixed grid) 

 Manually placing some elements on the grid and automatically generating the rest of the grid 
around the fixed elements or 

 Automatically generating the entire grid. 
 
Although each grid is modelled individually, the grid modelling process will also consider the links 
between different grids and the allocation of grids to schedules.  Each of these processes can be 
manually controlled or in some cases can be left to the auto scheduler and then edited. 

Note: Timetablers constructing a Fixed Grid Timetable will create the grid using manual construction 
without the need for the auto scheduler and many of the features described below will not be 
needed. 

The following reports may be useful in the execution of grid modelling: 

 Student Fit Report 

 Load Table 

 Conflict Matrix Report  
 
Samples of these reports may be viewed in the RM: Timetabling Manual 
 

4.6.1 Unlocking the Grid 

Upon entry of the grid modelling screen, the user will be prompted to unlock the grid.  No changes 
may be made to the grid until it is unlocked.  Unlocking the grid takes a snapshot of the grid so that 
the timetabler can revert to the initial position. 
 
Multiple snapshots may be taken of the grid at anytime and then changes made.  The user may later 
retrieve a snapshot and revert to a previous snapshot if required.  Student Fit Statistics may be 
viewed to note the effect of changes and to highlight problem bands and/or subjects. 
 
The screen will open in the Horizontal View 
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Indicates that the grid has been saved to the timetable. 
 

 

4.6.2 Manual Teaching Set Placement 

Teaching sets may be manually placed on the Bands or Band Records.  To display a list of available 
teaching sets click on Display Teaching Sets.  
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A list of teaching sets will appear on the left hand side of the window.  

Note: If no teaching sets appear, check that the number of teaching sets required for each has been 
entered in the Subject Load Table. 

Teaching Sets may be dragged and dropped onto relevant bands or band records.  
The action of placing sets onto the grid in a particular cell will fill the band records up to the subject 
frequency if the subject frequency is less than or equal to the band frequency.  If the subject 
frequency of the set is greater than the band record, the user will still be able to place the teaching 
set but a warning message will occur and the user may decide to either change to another band 
record with a greater frequency or change the frequency of the band or subject. 
 
Teaching sets may also be typed into the box and a band or band record selected by clicking in the 
cell and clicking the green tick to place the teaching set. 
 

 
 
All manually placed teaching sets will be marked as Fixed Elements and as such will not be moved 
by any auto scheduling process unless marked as not fixed (see below). 
 
Once a teaching set has been allocated to a band or band record, right clicking on the cell will 
produce a menu listing these options: 
 

 
 
The first three options will only be available if the band/band record is unlocked. 
 

4.6.3 Adding a Teaching Set within Grid Modelling 

If additional teaching sets are needed once the grid modelling process has begun, it is not necessary 
to return to the Subject Load Table.  Additional teaching sets may be added or deleted by selecting 
Tools>Add Teaching Set or Delete Teaching Set.  Subject Load Table details will be automatically 
updated.  At the time of adding a teaching set the user will be prompted to add students to the 
teaching set.  The students may be added here or later through the Move Student function. 
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4.6.4 Moving a Teaching Set 

Moving teaching sets from one band to another may be necessary to resolve an unrecognised 
resource conflict or to improve the fit of students.  Any movement of a teaching set is likely to result 
in students who previously fitted the subject becoming unfitted due to a clash and students who did 
not previously fit the grid to now fit.  The timetabler must ensure that students affected by this move 
are refitted prior to closing the grid.  Several moves can be made prior to identifying and resolving 
these clashes. 
 

To move a teaching set: 

 Right click on the selected set, and choose Move Teaching Set. 
 
Three options are provided to define the way that students will be managed within this move. 
 

 
 

 Select the appropriate option and then click on OK. 
 

 Select the band that the teaching set is to be moved to and then click on OK. 
 

 
 
The teaching set will be moved and placed onto the band selected. 
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4.6.5 Locking/Unlocking Bands 

Bands may be locked or unlocked at any time by selecting Tools>Lock all Bands or Unlock all 
Bands.  Once a band has been locked only limited functions are available and the contents of the 
band are protected.  For a full selection of tools to be available the band must be unlocked. 
 

 
 
 

4.6.6 Horizontal view 

There are two ways of viewing the Grid Modelling screen – Horizontal and Vertical.  Some tools and 
functions are available from both views, others only from one view. From the Timetabling sidebar, 
select Grid Modelling and the following window will appear:  
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4.6.7 Vertical view   

To change to Vertical view, click on Switch View and Vertical view and the following window will 
appear: 
 

 

 
 

4.6.8 Fixed Grid Elements 

Teaching sets may be manually fixed so that they can‟t be moved unless marked as a non-fixed 
element at a later date.  This option is particularly useful if manually placing some teaching sets and 
then auto-scheduling the rest. 
 

 
 
To fix a teaching set on the relevant band/band record: right click and from the menu select Mark 
as a Fixed Element. The teaching set will be marked as below. 
 

 The (F) indicating it is a fixed element. 

Note: Teaching Sets manually placed onto the grid are fixed by default. 
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4.6.9 Locking the Grid  

Upon exiting the grid modelling screen the user will be prompted to lock the grid and to save 
changes made or not.  The user must lock the grid prior to exiting this window. 
 

 
 

ACTIVITY: Grid Modelling 

Timetabling > Grid Modelling 

Creating a fixed grid 

 Unlock  the Yard Duty Grid 

 Click Display Teaching Sets  

 Drag and drop each of the Duty sets (one for each duty area) onto the grid. 
 

 
 

Click on  to view the band records (one for each duty session) 
 

 Lock  the Duty grid 

 Click Yes to save 
 
 

4.6.10 Entering Auto-scheduling Constraints 

The following constraints are only useful if the auto-scheduling process is to be used.  The 
constraints are optional but if used may produce a better timetable with optimal use of fixed 
resources. 
 

Fixing Grid Elements 

It is possible to fix and lock Teaching sets and Bands manually.  The effect of fixing and locking will 
signal to the auto-scheduling process to work around these fixed elements while continuing to assess 
conflicts by placing teaching sets and students around these elements. 
 
Teaching sets may be filled manually through Grid Modelling>Tools>Move Students.  
 
Students will be able to be added to a set either from an existing set or from the cohort list.  Once 
students have been added to a set they may then be locked into the set.  If a student is locked into a 
set they cannot be moved out of the set either manually (unless the set is unlocked) or by the auto-
scheduling process.  Teaching sets may also be filled automatically through the Tools>Fit All 
Students function. 
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Note: Students may be manually added to Teaching Sets in two other areas: 
Timetabling>Preferences>Teaching Sets or Timetabling>Timetable>Functions>Move Student. 

 

ACTIVITY: Fixing and Locking Teaching Sets and Students 

Timetabling > Grid Modelling 

Fixing Teaching Sets 

 Unlock the Upper School grid 

 Click Show Teaching Sets  

 Drag the Home Room teaching sets onto Band 1  
 

 
 

 Right click on one of the Year 12 Home Rooms and choose Show Teaching Set Members 
 

 
 
All of the students are locked into the set, that is the Autoscheduler cannot move them out. 
 

 Close Teaching Set Members 
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Timetabling > Grid Modelling > Tools > Move Students > Unplaced Students 

Placing Students 

 Highlight Home Room 11 

 Click Select those students matching specified criteria  

 Find the students in 10.1 
 

 
 

 Ensure that 11HR_1 is selected 
 

 
 

 Click Place 

 Click OK to save the changes 
 

 In the same way place the students in 10.2 into 11HR_2 and the students in 10.3 into 11HR_3 

 Close Move Students 
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Locking a Teaching Set 

 Right click in 11HR_1 and select Lock Teaching Set.  
 

 
 

 Repeat for 11HR_2 and 11HR_3 
 
No student can now be moved in or out of those sets by the Autoscheduler.   
 

Locking a band 

 Click on the padlock adjacent to Band 1 
 

 
 
The Autoscheduler may not place any other teaching sets on this band. 
 
 
 

4.6.11 Subject Constraints 

Timetabling > Grid Modelling > Grid Constraints 

Users may define subject constraints before a timetable is generated.  Constraints are used by the 
auto-schedule process, but will also be used for validation during manual placement of fixed 
elements. 
 
Constraint categories are: 

 Keep Together Sets – sets which must occur at the same time 

 Keep Apart Sets – sets which must not occur at the same time 

 Linked sets – sets that must have the same membership of students 
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ACTIVITY: Entering Grid Constraints 

Timetabling > Grid Modelling > Grid Constraints > Keep Together 

2AMAT_1 and 3AMAT_1 are to be on the same band 

 Click Add Constraint  

 Give the constraint a name and click OK 

 Highlight 2AMAT_1 and 3AMAT_1 in the Available Teaching Sets list 

 Click Add Selected Teaching Sets  
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Timetabling > Grid Modelling > Grid Constraints > Keep Apart 

3XHIM_1 and 3XHIM _2 are to be scheduled at different times 

 Click Add Constraint  

 Give the constraint a name and click OK 

 Highlight 3XHIM _1 and 3XHIM _2 in the Available Teaching Sets list 

 Click Add Selected Teaching Sets  
 

 
 

 Close Constraint Definition 
 
 
 

4.6.12 Inter-grid Linkage 

Timetabling > Grid Modelling > Functions > Inter-grid Linkage 

The Inter-grid Linkage table is used to link band records from different grids into common time slots.  
Time slots link to the period structure that was previously created for the cycle and grid. 
 
The user may populate the inter-grid linkage table in one of three ways: 

 Manually linking all bands on the table and generating nothing 

 Manually linking some bands containing fixed elements on the table and automatically 
generating the rest of the table around the manually placed bands  

 Automatically generating the entire table 
 
If the Inter-grid Linkage table is being manually populated, this may be done prior to or after the 
population of grids with teaching sets.  Completing the Inter-grid Linkage table early will enable the 
timetabler‟s plans to be recorded and resources more readily tracked.  
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The Inter-grid Linkage table will be created for the entire timetabling year, with each schedule 
appearing within it.  The table may be filtered by schedule so that all grids with concurrent band 
records may be displayed in isolation. 
 
Selecting Timetabling > Grid Modelling and unlocking the grid and then clicking on the Functions 
menu and choosing Inter-grid Linkage table will display the following screen: 
 

 
 

To add another time slot, click on add a slot.    A time slot will be added onto the end of the 
existing slots.  The new slot will be available for all grids. 
 
Right clicking on an individual cell will produce the following menu. 
 

 
 
Display Teaching Sets will list all teaching sets associated with the band record. 
 
Mark as Unavailable will highlight the slot as unavailable and no band record will be able to be 
placed on the slot until it is made available by right clicking and selecting Make Available. 
 
Unlink Slot will delete any band record linked to the slot 
 
The last two functions will only be available if the grid has not been saved to a timetable. 

Note: Best practice would indicate that all schedules be completely linked together before saving so 
that the user can check that the timetable can be resourced. 
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ACTIVITY: Completing the Inter-grid Linkage Table 

Timetabling > Grid Modelling > Functions > Inter-grid Linkage 

 Click Display Band Records  

 Select the Upper School grid for Semester 1 

 Complete mapping band record to slots by dragging the band records and dropping them into 
the desired slots   

Note: See the table on the next page for an explanation of how Band Records were assigned to 
Slots. 

 
 

 Right click in each of the remaining slots and select Mark as Unavailable 
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Inter-Grid Linkage Table/Timeslot Mapping for Upper School Semester 1  

 Monday Tuesday Wednesday Thursday Friday 

 Slot 
Band 

Record 
Slot 

Band 
Record 

Slot 
Band 

Record 
Slot 

Band 
Record 

Slot 
Band 

Record 

Home 
Room 

1 1.1 2 1.2 3 1.3 4 1.4 5 1.5 

Lesson 1 6 2.1 11 7.1 16 6.2 21 5.3 25 3.4 

Lesson 2 7 3.1 12 2.2 17 7.2 22 6.3 26 4.4 

Lesson 3 8 4.1 13 3.2 18 2.3 23 7.3 27 5.4 

Lesson 4  9 5.1 14 4.2 19 3.3 24 2.4 28 6.4 

Lesson 5 10 6.1 15 5.2 20 4.3   29 7.4 

 
 

Timetabling > Grid Modelling > Functions > Inter-grid Linkage 

 Select the Yard Duty grid and Term 1 

 Click on Show Band Record Display   

 Drag and drop Band Records 1.1 to 1.10 into Slots 30 to 39 
 

 
 

 Exit the Inter-Grid Linkage Table 
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4.6.13 Time Slot Mapping 

Time Slot Mapping is the act of mapping Band Records to the Period Structure. 
 
Selecting the Timetabling Sidebar and Grid modelling, unlocking any grid within the timetabling 
year, clicking on the Functions menu and choosing Time Slot Mapping from the menu, will display 
the following screen.  
 

 
 
Time slots may be dragged and dropped around the period structure.  If the time slot is dragged to 
an already populated cell a warning message will appear before swapping the contents of the cell.  
Right clicking on the time slot will display View Slot Details.  If this is clicked a window will appear 
that allows the user to view information about the grid, schedule and band record for that particular 
time slot.   

           
 
Saving the time slots will store the row labels, days and row numbers for this grid. 
 

Note: The time slots may be changed at any time and can be completed before the grid has been 
completely modelled. 
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ACTIVITY: Time Slot Mapping 

Timetabling > Grid Modelling > Functions > Time Slot Mapping 

 Drag and drop Slots 1 to 5 into the H periods 

 Drag and drop Slots 30 to 39 into the R and L periods  
 

Note: The period structure for Thursday is different. 

 

 
 

 Drag and drop Slots 6 to 29 into the teaching periods  
 

 
 

 Save and Close 
 
 
  



 

Time Advanced.docx 16-Sep-09 

Page 89 of 123 

   © 2009 RM Asia-Pacific Pty Ltd 

 

 

4.6.14 Auto-scheduling 

Timetabling > Grid Modelling > Functions > Autoschedule 

The auto-schedule process will create a grid that optimises the fit of student preferences, taking into 
account user nominated constraints on subjects and teacher and room resources. 
 
The following constraints can be selectively applied during the auto scheduling process: 
 
 Mandatory Desirable Optional 

Number of Sets of a Subject    

Maximum and Minimum Class Sizes    

Matching Subject and Band Frequencies    

Resource Usage of other Grids    

Staff Preferred Subjects    

Subject Preferred Rooms    

Inter-grid Linkage    

Keep Apart Sets    

Keep Together Sets    

Linked sets    

Locking students in Sets    

Locking Sets    

Locking Bands    

 

Note: The mandatory constraints will be applied, and should be checked by the timetabler prior to 
initiating the auto scheduling process.  Incorrect or incomplete constraints may result in 
unacceptable solutions. 

 
The auto-schedule process will function as a wizard requiring the user to nominate various settings 
within three screens before the process begins.  The fourth screen is displayed while the auto-
scheduler is in process.  A user may cancel the auto-schedule process at any time by clicking Cancel 
from any of the first three screens or Ctrl + Break and then clicking Cancel in the fourth screen.  At 
certain stages of the auto-schedule process cancelling may corrupt the data file, if this is the case a 
warning will be displayed on the screen to that effect. 
 
In screen 1 the user may select previously defined constraint settings (that is linked sets, keep apart 
sets or keep together sets).  The user may also elect to use threshold settings and resource 
monitoring for teachers and rooms.  Resource monitoring can only be selected if staff preferred 
subjects and/or subject preferred rooms has been entered.  Threshold settings allow the user to fit 
the timetable even if teachers and/or rooms are a nominated amount short.  Resource monitoring, if 
ticked, will allow the user to monitor the placing of teachers and/or rooms.  
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Screen 2 will display a list of related grids that have the potential to share resources with the current 
grid.  If the user wishes the auto-schedule process to take into account resources from other grids 
the relevant grids must be included.  Grids saved to the Timetable are always included.  The inter-
grid linkage table may be edited by clicking on the Edit Grid Links button.  
 

 
 
Screen 3 allows the user to view the number of available Timetable Cycle slots.  The user may also 
indicate the number of possible solutions required and the variants of the main solution may also be 
requested if required. 
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The auto-schedule process completes the following functions in the listed order: 

 Examining Teacher and Room preferences 

 Calculating possible teacher use – Selected Schedules 

 Calculating possible room use – Selected Schedules 

 Making initial allocation of students to teaching sets 

 Assessing initial allocation of students to teaching sets 

 Improving student allocations to teaching sets 

 Examining current Teaching Set to Band assignments 

 Saving newly created timetable details 
 
A completion report is displayed at the end of the auto-schedule process showing any conflicts 
and/or student dropouts created by the process.  The user may then relax or tighten constraints and 
run the auto-scheduler again or accept the result and manually manipulate the grid to produce a 
better grid.  
 

 
 

Note: The time taken for the auto-schedule process is dependent on the size of the school and 
number of constraints used. 
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Activity: Auto-scheduling 

Timetabling > Grid Modelling > Functions > Autoschedule 

Auto scheduling a grid 

 Check both boxes under Resource Reporting and Thresholds 

 Give equal weighting to Student Preferences and Resource Availability and to Staff and Room 
Resources 

 

 
 

 Click Next 
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 Deselect all other grids and click Next 
 

 
 

 Enter 1 possible solution 

 Click Next 
 
The Auto-schedule process will commence.  A completion report will be printed to the screen.  The 
user may print this report. 
 

 Click Close 
 

Note: The user may manually resolve conflicts or tighten/relax constraints and run the auto-
scheduler again. 
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4.6.15 Refining Student Placement 

Once all teaching sets are in place, it is now time to refine student placement for the timetable.  
Student Placement involves ensuring that all students are placed in a teaching set at any one time 
and there are no clashes or unplaced preferences. 
 
This process will involve the use of the Move Student Function to manipulate the placement and 
balance of students within sets of multi-set subjects and the use of the Student Course function to 
manipulate and fit individual students. 
 

Move Student Function 

The Move Student function is available in two places: 

 Timetabling > Grid Modelling > Tools > Move Students 

 Timetabling > Timetable > Functions > Move Students  
 
The Move Student function allows the user to move or redistribute teaching sets, balance all sets, 
view the results of any moves, resolve conflicts and place unplaced students. 
 
Move/Redistribute allows the user to highlight any teaching set and students in the teaching set will 
then be automatically highlighted.  The Move Students option allows the user to highlight any or all 
students and move them to another teaching set for the same subject.  If there is more than one 
destination teaching set available, using the Redistribute function will try to place students with the 
minimum of dropouts.  Remove will remove the teaching set from the grid and any students in that 
set will become unplaced students.  
 

 
 
After any attempted change the View Results tab will be shown to display the success or failure for 
individual students of any move.   
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The report may be printed from this screen by selecting Print Log.  If Success is listed, the student has 
been successfully moved to the destination teaching set.  If Failed is listed the student has not been 
moved but remains in their original teaching set.  If Dropout is listed the student is now not placed in 
any teaching set for that subject and remains unplaced. 
 

 
 
Balance all Sets attempts to redistribute students to allow more equitable teaching sets.  Users can 
select some or all teaching sets to be balanced.  Highlighting the relevant teaching sets and clicking 
on Balance Sets will attempt to redistribute the students. 
 

 
 
Once the balancing of the sets has been set in motion the Graphical Display of teaching sets will be 
automatically displayed.  If the system could balance teaching sets without allowing any dropouts 
the graph will automatically adjust to reflect the balancing. 
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Conflict Resolution allows the user to select some or all students for a grid and Check for Conflicts, 
that is, check for student clashes.  Any clashes will be listed and the user may Resolve Conflicts from 
this screen. 
 

 
 
Unplaced Students displays any subjects in red that have any unplaced students.  All other subjects 
and placed students are also listed.  Students who are unplaced are listed in red and have a U 
placed next to their name.  The third column displays associated teaching sets for the highlighted 
subject.  Highlighting the appropriate subject(s), student(s) and teaching set(s) and clicking Place will 
attempt to move students into teaching sets.  The Remove function will move a placed student from a 
teaching set.  The Fit All function will attempt to place all unplaced students into relevant teaching 
sets.  Auto Promote promotes students‟ reserve preference, after which Fit All may be attempted 
again.  The success or failure of the attempted placements will be shown on the View Results tab that 
will display automatically.   
 

 
 
If the move has been successful, clicking OK will save the move.  If the move has been unsuccessful 
and the user wants to revert all students to their original teaching sets, clicking Cancel at any time 
will not save any changes.  If the user is in the Grid Modelling screen the use of snapshots may be 
advantageous to check the results of any moves. 
 
Allow Oversize Sets if checked will create teaching sets that are larger than the maximum listed in 
the Subject Load table if this will allow more students to be fitted into the teaching sets.  Movements 
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shows the number of student moves that have been allowed for this grid.  Attempts displays the 
number of attempted moves to place students on the grid. 
 
The Timetable Year and/or Grid may be changed at any time while working within the Move 
Students function.  
 
Useful reports to view while analysing student fit are the 

 Auto-scheduler Completion Report 

 Student Fit Report 

 Load Table Report  

 Conflict Matrix Report  
 
These reports except for the auto-scheduler completion report are found in Timetabling > Reports > 
Planning and Preparation. 
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ACTIVITY: Fitting Students to the Grid 

Timetabling > Grid Modelling 

To fit as many students as possible to the Upper School grid:  

 Click Update Student Statistics    
 
This will indicate how many students are unplaced overall and for each band record. 
 

Tools > Move Students 

 Click on the Unplaced Students tab   
 
Any subjects highlighted in red have unplaced students.  The students highlighted in red are the 
unplaced students for the selected subject. 
 

 
 

 Click Auto Promote, then Fit All  

 Select Ignore students in off-grid sets and click OK 

 Click OK to accept changes and close the Move Students window 
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 Take a FULL Snapshot of your grid     
 

 
 

 Enter a Code and Description for your snapshot 
 

 
 

Tools > Move Students > Unplaced Students  

 Select Allow Oversize Sets and then click on Fit All again 

 Click OK to accept any changes and close the window 

 View your grid, if any sets are significantly oversized you may wish to retrieve  your 
snapshot   

 



 

Time Advanced.docx 16-Sep-09 

Page 100 of 123 

   © 2009 RM Asia-Pacific Pty Ltd 

 

Balancing Sets 

Tools > Move Student > Balance Sets 

 Highlight any unbalanced sets (especially if some are over-sized)and click Balance Sets 
 

 
 

 Click the View Results tab 

 Click OK to accept the solution  
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Moving teaching sets on the grid 

 Take another FULL Snapshot of your grid 

 Right click on a teaching set you want to move and choose Move Teaching Set 

 Choose Retain Students in Teaching Set and click OK 
 

 
 

 Select the band you want to move the teaching set to and click OK 
 

 
 

Tools > Move Students  > Conflict Resolution 

 Click Select All and Check for Conflicts 

 Click Resolve Conflicts 

 Click the View Results tab 

 Click OK to accept the solution 
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Depending on your placement of teaching sets on the grid you may also wish to: 

 Add Teaching sets through the Tools menu 

 Delete Teaching sets through the Tools menu 
 

Note: You can revert to an earlier snapshot at any time. 

 

 Lock  the grid and click Yes to save the changes 
 
 
 

4.6.16 Copying Grid Bands 

Activity: Copying Grid Bands 

Timetabling > Preferences > Subject Load Table 

 Click Edit  

 Enter the number of teaching sets required for each 1B, 1D, 2B and 3B subject 

 Click OK to save 
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Timetabling > Grid Modelling 

 Unlock  the Upper School grid  

 Right click in the grey area next to Band 2 
 

 
 

 Click Copy Band  

 Check Insert New Band At End and select the Semester 2 schedule 
 

 
 

 Click OK and Yes 
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 Right click in a cell on Band 8 containing a Semester 1 Subject (that is 1A, 1C, 2A or 3A) 

 Select Remove Teaching Set 
 

 
 

 Select Retain Students in Teaching Set and click OK 
 

 
 

Timetabling > Grid Modelling  

 Click Display Teaching Sets  

 Select the Semester 2 equivalent of one of the teaching sets you have removed  

 Drag and drop it onto Band 8 

 Repeat for any other Semester 1 subjects on Band 8 
 

 

Note: In school this will need to be repeated for each band containing semesterised subjects. 
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Timetabling > Grid Modelling > Tools > Unplaced Students 

 Select one of the subjects for which you just placed a teaching set on the grid 
 
(If there is more than one teaching set for that subject: 

 Click Select …   

 Find the students in the Semester 1 equivalent of the teaching set you have placed on the grid 
 

 
 

) 
 

 Click Place 

 Click OK 
 

 Repeat for the other teaching sets placed on Band 8  
 

 Lock  the grid and click Yes to save the changes 
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Timetabling > Timetable Setup > Individual Grid Parameters > Band Allocation 

 View the additional band 
 

 
 
 
 

4.6.17 Editable Grid Display 

Activity: Moving Sets on a Band 

Timetabling > Timetable Setup > Timetable Grids 

 Select the Upper School grid and click Edit  

 Check Editable Grid Display 
 

 
 

 Close  
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Timetabling > Grid Modelling  

 Unlock the Upper School grid 

 Click Show Teaching Sets   

 Drop and drag the Spacer into the appropriate cells so that the stage 3 sets are aligned  

Note: Move Teaching Sets  may be used to move teaching sets across bands. 
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4.6.18 Save as Timetable 

Saving the Grid as a Timetable will incorporate the grid into the total overview of the school‟s use of 
resources, that is, the timetable.  The action of saving locks the band records in the saved schedule 
into the grid.  Once the grid has been saved it may not be remodelled.  However a grid may be 
unsaved if necessary and then may be remodelled.  
 
Unlocking the grid, clicking on the Functions menu and choosing Save as Timetable from the menu 
will display the following screen.   
 

 
 
Highlight the grid to be saved and click the Save button. 
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ACTIVITY: Save As Timetable 

Timetabling > Grid Modelling > Functions > Save as Timetable 

Save the Upper School and Yard Duty grids to the timetable. 

 Highlight the Semester 1 Upper School grid and the Term 1 Yard Duty grid  
 

 
 

 Click Save and Yes 

 Close  

 Lock  the grid and click Yes you do wish to save the changes 

 Click Close 
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4.7 Allocating Staff and Rooms 

Allocate Staff and Rooms allows the user to indicate which teacher and room will be used for each 
occurrence of a teaching set on the timetable. 
 
Allocation and maintenance of staff and room details is performed within the Timetable Sidebar 
function.  Selection of this function will open the timetable that applies to the current date.  The 
timetabling year and timeslice can be selected to view the timetable to be staffed and roomed. 
 
Only grids that have been Saved as Timetable will be visible. 
 

 
 
Staff and rooms may be allocated to subjects on the timetable in one of three ways: 

 Manually placing staff and rooms for every occurrence of a teaching set on the grid, 

 Auto-allocate all staff and rooms 

 Manually allocate staff and/or rooms for some teaching sets and then auto-allocate staff and/or 
rooms to the remaining teaching sets. 

 

4.7.1 Manual Placement of Staff and Rooms 

Teaching staff and rooms are allocated manually by highlighting an appropriate teaching set, right 
clicking and selecting from the list of functions. 
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4.7.2 Auto-allocation of Staff and Rooms 

Auto-allocation of staff and rooms relies on subject-preferred rooms and staff preferred subject and 
rooms.  The auto-allocate staff and room function is available from the Function menu item within 
the Timetable sidebar item. 
 

 
 

Auto-Allocate Staff 

The Auto Allocate Staff function attempts to assign staff to all class meetings that are currently 
displayed in the Timetable window 
 

Note:  The Auto Staff Allocation function will only allocate staff to subjects in their list of preferences.  
No allocations will be made where staff/subject preferences have not been made. 

 
If a set has been partially allocated to a single teacher and that teacher has the subject of the set in 
their list of preferences and it can allocate the remaining meetings to the same teacher then it will 
allocate the remaining meetings to the same teacher. 
 
If a set has no teacher allocations and it can be taught by a single teacher and the teacher has the 
subject of the set in their preferences, then the teacher may be allocated to teach the set (this also 
takes account of preference rank).  It will do this first for staff who only have one subject preference, 
and then for remaining staff.  Over allocation of staff is not allowed at this stage (i.e. staff will not be 
timetabled above specified Net FTE). 
 
If any class meetings remain to be allocated, then you will be asked if over-allocation of staff is 
allowed.  If it is then the previous step is repeated allowing staff to be timetabled above specified 
Net FTE. 
 
If a Combined Class has class meetings relating to two or more subjects, then a staff/subject 
preference for either subject will be sufficient for an allocation to be made.  Note that this means 
that some subjects may therefore be allocated to non-preferred staff. 
 
If a displayed class meeting is part of a Combined Class and is linked to a class meeting that is not 
displayed, then it will still attempt to allocate staff to the class meeting.  If successful then the 
allocation will apply to all class meetings that make up the Combined Class.  
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Auto-Allocate Rooms 

The Auto Room Allocation function will attempt to assign rooms to all class meetings that are 
currently displayed in the Timetable window.   

The Auto Room Allocation function will only allocate rooms to subjects in their list of preferences.  
No allocations will be made where room/subject preferences have not been defined. 

Rooms are allocated to class meetings for a set where the set is already partially allocated to a 
single room, as long as all of the remaining meetings can be allocated to the same room. 
 
Sets that are linked to a room by a „Must Have‟ preference will be allocated to the „Must Have‟ room 
as long as the room can be used for all meetings of the set. 
 
Sets that are linked to a room by a positive preference (Highly Desirable, Desirable, Take if 
Necessary) will be allocated to an appropriate room as long as the room can be used for all 
meetings of the set.  This will take account of the rank of the preference. 
 
The previous step is repeated on an individual class meeting basis – that is it does not check that all 
meetings of a set will be allocated to the same room.  Some meetings for a set may be allocated 
whilst others remain unallocated. 
 
Room allocation is then repeated on an individual class meeting basis. 
 
Before proceeding, users will be asked if they wish to proceed or to skip room allocation on an 
individual class meeting basis. 
 

 
 
If a Combined Class has class meetings relating to two or more subjects, then a room/subject 
preference for either subject will be sufficient for an allocation to be made.  Note that this means 
that some subjects may therefore be allocated to non-preferred rooms. 
 
If a displayed class meeting is part of a Combined Class and is linked to a class meeting that is not 
displayed, then it will still attempt to allocate rooms to the class meeting.  If successful then the 
allocation will apply to all class meetings that make up the Combined Class. For instance if the 
Combined Class includes a Science class and a Maths class, and the Science class has Lab 1 as 
preferred room and Maths class has M1 as a preferred room, then if the auto room allocation 
function is run with Maths classes only, it will select M1 for the Combined Class, whereas if the 
Science filter is applied then Lab 1 will be chosen. 
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Staffing and Rooming Reports 

Some reports that may be of use are:  

 Period Summary  

 Teacher Clash Summary  

 Staff Load 

 Room Clash Summary Report 

 Room Load 
 
 

ACTIVITY: Allocating Staff and Rooms 

Timetabling > Timetable 

Manually allocate a teacher and room to a teaching set 

 Filter to the 2010 timetable 

 Right click in one of the English classes and choose Allocate Teacher 
 

 
 

 Select Allocate Staff Member to ALL Class Meetings for the Teaching Set and click OK 

 Select Harris Barclay and click OK 

Note: As Harris Barclay has a preferred room, the room is also allocated. 
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Timetabling > Timetable 

Auto-allocate staff and rooms to the teaching sets for 2010 

 Click Functions 

 Select Auto-allocate staff  

 Read the prompts and click Yes  
 

Note: If staff are overloaded or there are teaching sets that cannot be allocated to a staff member, 
users will be given the option to display an exception report to the screen (that may be printed).  These 
teaching sets may be allocated manually or constraints relaxed and the auto-allocate process run 
again. 

 

 Click Functions again and select Auto-allocate rooms 

 Read the prompts and click Yes  
 

Note: If there are teaching sets that cannot be allocated a room, users will be given the option to 
display an exception report to the screen (that may be printed). These teaching sets may be allocated 
manually or constraints relaxed and the auto-allocate process run again. 

 

Rooms have been allocated to Yard Duty but not teachers 

 Filter to the Yard Duty grid 

 Right click in the first occurrence of duty 

 Select Allocate Teacher 

 Choose to Allocate Staff Member for the Selected Class Meeting 
 

 
 

 Select a suitable teacher and click OK 
 

 Repeat for each Duty Area for Monday recess 
 

 Close the Timetable 
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5 Timetabling Reports 
The current timetabling reports are available from Timetabling > Reports.  Most reports are also 
available by printing from the relevant screens within the Timetabling module. The following list of 
reports may change in the future to meet the changing needs of users. Samples of the available 
reports may be viewed in the Timetabling Manual. 
 
Timetabling Reports have been broken up into three areas: Data Validation, Planning and 
Preparation, and Operational and Maintenance. 
 

Data Validation Reports consist of:  

 Student Course Summary 

 Students Choosing A Subject 

 Students Choosing A Combination Of Subject 

 Students With Less Than A Given Number Of Subjects 
 
These reports allow the user to identify that correct subjects has been entered and allocated to the 
relevant students.  
 

Planning Preparation Reports consist of:  

 Student Fit Report 

 Load Table 

 Conflict Matrix 

 Staffing Requests 
 
These reports help the user in the planning and preparation of timetables. 

Operational and Maintenance Reports – Timetable consist of: 

 Horizontal Grid Summary 

 Vertical Grid Set Distribution 

 Period Summary 

 Exam Timetable 
 

Operational and Maintenance Reports – Student consist of:  

 Student Timetable by Date Range 

 Student Timetable by Grid 

 Student Load 

 Clearance Form 
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Operational and Maintenance Reports – Staff consist of:  

 Teacher Clash Summary 

 Staff Timetable  

 Staff Load 

 Relief Teacher Timetables 

 Teacher Usage Summary 

 Free Teacher Summary 
 

Operational and Maintenance Reports – Rooms consist of:  

 Room Clash Summary  

 Room Timetable  

 Room Load 

 Room Usage Summary 

 Free Room Summary 
 

Operational and Maintenance Reports – Teaching Sets consist of:  

 Teaching Set List (all Sets) 

 Teaching Set List by Schedule 

 User Defined Teaching Set Lists 

 Students and Their Teaching Sets 
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ACTIVITY: Timetabling Reports 

View the following reports 

Timetabling > Reports > O&M Reports Student > Student Timetable by Grid 

 View the 2010 timetables for several Upper School students 
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Timetabling > Reports > O&M Reports – Staff > Staff Timetable 

 View the 2010 timetables for several staff members 
 

 
 

Timetabling > Reports > O&M Reports – Teaching Sets > Teaching Set List by Schedule 

 Print the teaching set lists for the Upper School English classes for Semester 1, 2010 
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Activity: Review 

Note the pathways you would take to complete each of the following timetabling 
tasks. 

1. Add a new department 

 
 
 
 
 

2. Add a new subject 

 
 
 
 
 

3. Make a new subject available to a grid 

 
 
 
 
 

4. Add a new grid  

 
 
 
 
 

5. Allocate grid bands to schedules  

 
 
 
 
 

6. Manually place a teaching set onto a grid  

 
 
 
 
 

7. Lock a teaching set on the grid  
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8. Lock students into a teaching set 

 
 
 
 
 

9. Copy a grid band  

 
 
 
 
 

10. Manually allocate staff to yard duty 
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6 Support 
Should you require support please contact the Customer Service Centre (CSC) at the Department of 
Education and Training. 
 
Contact details below: 
 

6.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the problem. 
 

6.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

6.3 Email (CSC) 

customer.service.centre@det.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

7 Online Manuals and Training Notes 

7.1 RMA 

Online manuals and training notes are available to download in PDF format from the RM Asia-
Pacific website. 
 
www.rmap.com.au 
 
Select online manual login. 
Username: school 
Password: help 
 

7.2 STIMS Project 

The Department‟s Student Information Management Project (STIMS) website has numerous fact 
sheets and support documents for all SIS Administration modules. 
 
http://www.eddept.wa.edu.au/sis/ 
 
Links to the RM manuals are also available from the STIMS website or by going to Help within 
Integris. 

mailto:customer.service.centre@det.wa.edu.au
http://www.rmap.com.au/
http://www.eddept.wa.edu.au/sis/

